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About Pure ASP Upload 3 

Pure ASP Upload 3 is the most advanced upload solution ever!  Combining all the 

latest technologies in the web development world like AJAX, HTML5 and CSS3. All 

available at your fingertips and in your trusted Dreamweaver environment. With just a 
few clicks, you become an expert. 

Pure ASP Upload 3 empowers strong validated client and server side restricted 

uploads, making them more secure than ever. Full support for mobile file upload - now 

with IOS 6 and Android 4 you can upload any image from your mobile phone directly 
with a great looking HTML5 progress bar. 

It also supports the DMXzone Ajax Form - turn your form to a dynamic ajax form so that it is submitted and 

processed directly without any page refreshes and show the result directly inline! Combine Pure ASP Upload 

3 with DMXzone Ajax Form and you will get full Ajax File Upload! With real time accurate progress tracking in 

all the latest browsers! 

http://www.dmxzone.com/go/21205/ajax-form/
http://www.dmxzone.com/go/12064/pure-asp-upload-3/
http://www.dmxzone.com/go/12064/pure-asp-upload-3/
http://www.dmxzone.com/go/21205/ajax-form/
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Features in Detail 

 Increased performance - Pure ASP Upload 3 offers the best performance ever and  is up to twenty 

times faster than the previous version, using three times less memory. It is even faster than many of the 

best upload server components on the market and still it’s just pure script, so you don’t need to hassle 

your server administrator with extra components that need to be installed. Get ready for the best 
upload solution. 
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 Customizable progress bars - The build-in Dreamweaver menu enables you to select multiple 

predefined Progress bars and customize them. 
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 Progress bar preview - You can preview your progress bar design directly in Dreamweaver by clicking 

the “preview” button.  
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 Different options for each file upload field – You can specify different options for each file upload 

field. This way you can have each upload field stored in a different location and specify which file 
types are allowed per field.  

 

 File conflict handling – Determine how a file should be handled if its name conflicts with the name of 

an existing file in the directory. 
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 Specify the uploaded file types – From the dropdown menu you can select the file types that can be 

uploaded or enter their extensions in a comma separated list. Leave empty for no file restrictions. 

 
 

 Upload engine for Advanced HTML Editor 3 - You can use Pure ASP Upload 3 extension as an 

uploading solution in the Advanced HTML Editor 3. 

 

  

 Advanced client and server side upload restrictions - File size, image dimensions and type restrictions 

are checked client-side as well as server-side! This is the most secure way to allow uploads. Note that 

client side file size and image dimensions might not be allowed to be checked by all browsers due to 

security settings, but they will be checked server side anyway. 

 
 Multiple language support - Pure ASP Upload 3 contains advanced browser detection that 

determines the language of your visitor and translates the messages of the extension into their 

language.  

 

http://www.dmxzone.com/go/18424/advanced-html-editor-3/
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 Extended Data bindings - extended data bindings are available so that you can easily access the 

properties of the uploaded files and have total freedom to use them any way you intent to. Pure ASP 
Upload 3 allows you to set the properties of your form fields in the bindings menu.  
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 Fully object oriented - Pure ASP Upload 3 is fully object oriented, making the extension more 

advanced than ever. It collects all the information of the files that you upload server-side. The 

extension collects data such as filenames, file sizes and the size of images from the upload class so 
you can store these values in your database. 
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 Great Dreamweaver Integration - Interactive dialog in Dreamweaver with all the options you’ll need. 
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  Fully cross-browser compatible - Runs perfectly on any up-to-date desktop browser as well as mobile 

devices. 
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Before you begin 

Make sure to setup your site in Dreamweaver first before creating a page. If you don’t know how to do that 

please read this. 

Installing the extension 
Read the tutorial at http://www.dmxzone.com/go/4671/how-to-install-extensions-from-dmxzone/ 

 

Login, download the product, and look up your serial at http://www.dmxzone.com/user/products 

 

Get the latest extension manager from Adobe at  

http://www.adobe.com/exchange/em_download/ 

 

Open the .mxp file (the extension manager should start-up) and install the extension. 

 
If you experience any problems contact our Live Support! 

http://www.adobe.com/devnet/dreamweaver/articles/first_website_pt1.html
http://www.dmxzone.com/go/4671/how-to-install-extensions-from-dmxzone/
http://www.dmxzone.com/user/products
http://www.adobe.com/exchange/em_download/
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The Basics: Uploading Files with Pure ASP Upload 3  
In this tutorial we will show you how to upload files using Pure ASP Upload 3. 

*You can also check out the video. 

 

 

http://www.dmxzone.com/go/12064/pure-asp-upload-3/
http://www.dmxzone.com/go/21206/uploading-files-with-pure-asp-upload-3/
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How to do it 

1. We’ve already created a simple form that contains a file upload field.  
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2. Click on the Pure ASP Upload 3 icon and the window will appear. 
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3. In the general options select your form (1). We will leave the timeout (2) (maximum time that the 

upload script is allowed to run) empty for no time limitation and the max form size (3)( the max form 

size for all the form fields allowed to be uploaded) blank for the same reason. 
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4. Choose whether to store the Filename or the Full path if you are using a database to store the 

uploaded file names. In our case we choose to store the Filenames. 
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5. Select how the file should be handled if its name conflicts with a file that already exists in the upload 
folder. We choose the Make unique option.  
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6. We choose a different folder from the Upload folder field (1) as we want to store the files in a different 

one. Also, we leave empty the Max file size (2) as we don’t want any size limitation.  
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7. For our tutorial we will limit the uploaded file type only to images, without any restrictions for the 

images size. The redirect URL is only needed if you are NOT using Insert/Update Record behavior. 
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8. In the Progress tab (1) we will select one of the predefined progress bar designs, the HTML5 one (2). 
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9. You can customize the progress bar (1) the way you want and preview it directly in Dreamweaver 

(2). 
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10. Now you can save your work and preview the result in the browser.  
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Advanced: Using Pure ASP Upload 3 with Insert Record 
In this tutorial we will show you how to upload images and save their names, width and height into a 

database. 

*You can also check out the video. 

  

 

http://www.dmxzone.com/go/21207/using-pure-asp-upload-3-with-insert-record/
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How to do it 

1. We’ve already created a simple form with three fields in it. 
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2. Click the Insert button (1) and select the Pure ASP Upload 3 icon (2) in order the window to appear. 
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3. We want to store just the filename (1) in our database, in a different folder than the current one (2).  
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4. For our tutorial we limit the uploaded file type only to images. 
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5. We choose the HTML5 progress bar from the Progress tab.  

 

 
 



Pure ASP Upload 3 Manual 
DMXzone 

 

Copyright © 2012 DMXzone.com All Rights Reserved 

To get more go to DMXzone.com  

Page 31 of 64 

6. Now we are going to add two hidden fields that will be used to store the images width and height. 

From the Insert menu (1), select the Forms menu item (2).  
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7. Select the hidden field (1) and click on it (2) once it’s added. We give this hidden field a proper 

name: width (3). 
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8. Next, click the Add dynamic item button (1), select Upload file (2) and choose the Width binding (3). 

When you’re done, click OK. 
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9. We do the same with the height hidden field.  
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10. Now, we’re going to apply the Insert record behavior. From the Insert menu (1), choose the Data 

menu item (2) and select Insert Record (3).  
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11. In the Insert record window, we set the right database columns for our text fields (1) and store the 

Image name into a database column named Image (2). 
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12. In the next step we are going to store the width hidden field (1) value into the ImageWidth database 

column (2). 
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13. We do the same for the height hidden field. 
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14. Now you can save your work and preview the result in the browser. 

 

 



Pure ASP Upload 3 Manual 
DMXzone 

 

Copyright © 2012 DMXzone.com All Rights Reserved 

To get more go to DMXzone.com  

Page 40 of 64 

15. That’s how you can upload images and save their names, width and height into a database. 
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Advanced: Using Pure ASP Upload 3 with Update Record 
In this tutorial we will show you how to use Pure ASP Upload 3 with Update Record server behavior. 

*You can also check out the video.  

 

 

http://www.dmxzone.com/go/12064/pure-asp-upload-3/
http://www.dmxzone.com/go/21208/using-pure-asp-upload-3-with-update-record/
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How to do it 

1. We’ve already created a form that contains three fields – name, email and picture. Now, we’re 
going to apply the Update record behavior to this page so we can update the fields’ info. 
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2. We’ve already applied Pure ASP Upload 3 to this form and created a standard Dreamweaver 

recordset.  
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3. In the Recordset window, we’re filtering the recordset by an URL parameter named ID. 
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4. Next, select the Name field (1) and click the Bindings button (2), choose the Name binding (3) and 

click the Bind button (4). 
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5. We do the same for the Email and Picture fields, choosing the corresponding bindings - email and 

image. 
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6. Now we are going to apply the Update Record behavior. Click the Server behavior button (1), select 

the Add item button (2) and choose Update record menu item (3).  
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7. In the Update record window, make sure that your form fields are assigned to the corresponding 

fields in your database and click the OK button.  
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8. Now you can save your work and preview the result in the browser.  
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Advanced: Uploading Files to a Dynamic Folder  
In this tutorial we will show you how to upload files to a Dynamic folder using Pure ASP Upload 3. 

*You can also check out the video. 

  

 

http://www.dmxzone.com/go/12064/pure-asp-upload-3/
http://www.dmxzone.com/go/21209/uploading-files-to-a-dynamic-folder/
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How to do it 
1. For this tutorial we use a session variable that stores a username. We are going to use the username 

as a folder name. Click the Insert button (1) and select the Pure ASP Upload 3 icon (2) to open its UI.  
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2. Our upload folder is named “Uploads” and we want to create a folder for each user inside it. Enter: 

“Uploads/” & Session (“Username”). Username is the session variable that stores the username. This will 

create a new folder for every user that tries to upload. Non-existing folders will be auto-created 
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3. Now you can save your work and preview the result in the browser. 
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Advanced: Configure Uploads for IIS Web Applications 
This article describes how to configure Internet Information Services (IIS) to allow more-secure file uploads 

through a Web application. Many Web applications such as Content Management Systems require 

supporting file uploads to the Web server that uses the Web application. Allowing files to be uploaded to the 

Web server that uses the Web application has security ramifications for the server, and you must understand 

all the implications for allowing this. This article guides you through securing your Web application uploads 

through IIS configuration. If your Web application has an automated installer, you can also incorporate the 

configuration in this article into your installer.  

 
Note Some Web applications use databases to manage uploaded content. However, this article focuses on 

applications that use the file system. 



Pure ASP Upload 3 Manual 
DMXzone 

 

Copyright © 2012 DMXzone.com All Rights Reserved 

To get more go to DMXzone.com  

Page 55 of 64 

How to do it 
Create a separate folder for your uploaded content and change the NTFS file permissions on the upload 

folder 

By doing this, you can configure the behavior of uploaded content differently from the rest of your Web 

application. Grant the upload folder Read and Write permissions for the IIS worker process identity. For IIS 6.0 

in Windows Server 2003, you can use the IIS_WPG user group for this. For IIS 7.0 and later, you can use the 

IIS_IUSRS user group.  

 
For more information about IIS_WPG, visit the following Microsoft Web page:  

Configuring Application Pool Identity in IIS 6.0 

For more information about IIS_ISURS, visit the following Microsoft Web page:  

Understanding the Built-In User and Group Accounts in IIS 7.0 

For more information about how to help secure files with NTFS permissions, visit the following Microsoft Web 
page:  

Securing Files with NTFS Permissions 

Note: In some cases, such as when impersonation is used, you would need to give Write access for the 

authenticated user context as well. 

Disallow Script Permissions on the upload folder 

Uploaded content for most Web applications are static content, such as images and documents. Uploaded 

content is not meant to be content that can be run, such as scripts or executable files. Therefore, it is 

important not to grant Script Permissions on this folder. Otherwise, users who can upload content can 

execute scripts in the context of your worker process identity on the server. If your Web application has logic 

to restrict uploads by file name extensions, you should use this restriction as a secondary measure. You should 
still make sure that your application’s upload directory has script permissions disabled.  

To disable script permissions in IIS Manager User Interface (inetmgr) in IIS 5.x and 6.0, follow these steps:  

1. Click Start, and then click Run. 

2. Type inetmgr in the Open box, and then click OK.  

3. In the tree view in the navigation pane, select the path of the upload directory of your Web 

application. 
4. Right-click this path, and then click Properties. 
5. Click the Directory tab, and then select None in the Execute Permissions list. 

For more information about how to how to set IIS permissions for specific objects, click the following article 
number to view the article in the Microsoft Knowledge Base:  

324068 How to set IIS permissions for specific objects  

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/12a3d96c-65ea-4210-96ad-86a801f6a88c.mspx?mfr=true
http://learn.iis.net/page.aspx/140/understanding-the-built-in-user-and-group-accounts-in-iis-70/
http://technet.microsoft.com/en-us/library/cc757422%28WS.10%29.aspx
http://support.microsoft.com/kb/324068
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Alternatively, you can disable script permissions by using metabase configuration in IIS 6.0 by setting 
AccessFlags property’s AccessScript flag to False at the upload directory level. For more information and for 

sample scripts that can be changed for this use, visit the following Microsoft Web page:  

AccessFlags Metabase Property (IIS 6.0) 

To disable script permissions in configuration for IIS 7.0 and later versions, you have to set the accessPolicy 

flag on the handlers section not to have the Script value.  

 
For more information about how to do this in IIS 7.0 and later versions, visit the following Microsoft Web page:  

Configure Request Restrictions for a Handler Mapping 

Note Make sure that you read the Script value for the access flags.  

 
For more information about how to set permissions, visit the following Microsoft Web page:  

Securing Sites with Web Site Permissions 

The Web application should restrict uploads to authenticated and authorized users only 

This gives the server administrator the ability to audit uploads through the Web application. In the case a user 

is trying malicious activity, it gives the server administrator an easy mechanism to keep the application 

functional while blocking out users who are trying malicious activity. When users can upload scripts and 

execute them through the Web application, authentication should be required and the IIS application pool 

identity hosting the Web application should not be an Administrative account. 

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/e9b6d626-9583-4d59-b7f7-a079ec47461c.mspx?mfr=true
http://technet.microsoft.com/en-us/library/cc730969%28WS.10%29.aspx
http://technet.microsoft.com/en-us/library/cc756133%28WS.10%29.aspx
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Advanced: Uploading Large Files on Windows 2003 Server 
In this article we will show you how to upload large files on Windows 2003 server.  

For IIS6.0 users, the AspMaxRequestEntityAllowed property specifies the maximum number of bytes allowed in 

the entity body of an ASP request. If a Content-Length header is present and specifies an amount of data 
greater than the value of AspMaxRequestEntityAllowed, IIS returns a 403 error response.  

This property is related in function to MaxRequestEntityAllowed, but is specific to ASP request. Whereas you 

might set the MaxRequestEntityAllowed property to 1 MB at the general World Wide Web Publishing Service 

(WWW Service) level, you may choose to set AspMaxRequestEntityAllowed to a lower value, if you know that 

your specific ASP applications handle a smaller amount of data. 
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How to do it 
1. IIS6.0 prevents the upload of files more than +200Kb. So you need to make some changes in the 

default IIS settings first. 

 

2. Before you edit the file, be sure to stop the IIS service first or else you won’t be able to save the file. 

 
3. Open your metabase.XML which is located in c:\Windows\System32\Inetsrv find the line 

“AspMaxRequestEntityAllowed” and change it to “1073741824”. This is 1GB - of course you can enter 

another value to suite your needs. 

 

 

 



Pure ASP Upload 3 Manual 
DMXzone 

 

Copyright © 2012 DMXzone.com All Rights Reserved 

To get more go to DMXzone.com  

Page 59 of 64 

Advanced: Uploading Large Files on IIS7 (Windows Vista/Windows 

2008) 
In this article we will show you how to upload large files on IIS7 (Windows Vista/Windows 2008). In order to be 
able to upload large files you need to change a special option in IIS called maxAllowedContentLength to 

allow uploading larger files. 
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How to do it 

1. Click Start. In the Start Search box, type Notepad. Right-click Notepad, and then click Run as 

administrator. 
*Note If you are prompted for an administrator password or for a confirmation, type the password, or 

click Continue. 

 

2. On the File menu, click Open. In the File name box, type 
%windir%\system32\inetsrv\config\applicationhost.config, and then click Open. 

 
3. In the ApplicationHost.config file, locate the <requestLimits> node. 

 
4. Remove the maxAllowedContentLength property. Or, add a value that matches the size of the 

Content-Length header that the client sends as part of the request. By default, the value of the 
maxAllowedContentLength property is 30000000. 

 
For example, modify the following configuration data inside the <requestFiltering> section. 

    <requestLimits maxAllowedContentLength =“<length>“ /> 

 
5. Save the ApplicationHost.config file.   

For more information see: http://support.microsoft.com/kb/942074/ 

More info about content filtering in IIS:  

http://learn.iis.net/page.aspx/143/how-to-use-request-filtering/ 

http://www.iis.net/ConfigReference/system.webServer/security/requestFiltering/requestLimits  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://support.microsoft.com/kb/942074/
http://learn.iis.net/page.aspx/143/how-to-use-request-filtering/
http://www.iis.net/ConfigReference/system.webServer/security/requestFiltering/requestLimits
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Reference: Customizable Progress Bar  
The build-in Dreamweaver menu enables you to select multiple predefined Progress bars and customize 

them. You can preview your progress bar design directly in Dreamweaver by clicking the “preview” button. 
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Circle  

 
 

Classic Pure Upload 2 

 
 

HTML5 

 
 

Laboratory 
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Mac Look 

 
 

Speedometer 

 
 

Vista Look 

 
 

Windows Look 
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Video: Uploading Files with Pure ASP Upload 3 

  
With this movie we will show you how to upload files using Pure ASP Upload 3. 

 

 

 

 

 

 

Video: Using Pure ASP Upload 3 with Insert Record 

 
 
With this movie we will show you how to upload images and save their names, width and 

height into a database. 

 

 

Video: Using Pure ASP Upload 3 with Update Record 

 

With this movie will show you how to use Pure ASP Upload 3 with Update Record server 

behavior. 
 

 

 

Video: Uploading Files to a Dynamic Folder 

 

With this movie we will show you how to upload files to a Dynamic folder using Pure ASP 

Upload 3. 
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